
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

ToeTap : Rigging 
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Copyright and Terms of Use 
Please leave all references to FridgeMonsters intact in the documentation and 
code examples.  
 
1. Except as otherwise provided, the contents of these notes shall not be 
reproduced, republished, uploaded, posted, transmitted or distributed 
electronically or non-electronically in any way, without FridgeMonsters prior 
written permission. 
 
2. Modification of any of the contents or use of the contents for any other purpose 
will be a violation of FridgeMonsters copyright and other intellectual property 
rights. Graphics and images in these notes are protected by copyright and may 
not be reproduced or appropriated in any manner without written permission of 
FridgeMonsters. 
 
3. FridgeMonsters reserves all rights to deny or restrict access to these notes to 
any particular person or persons, or to block access from a particular Internet 
address to the FridgeMonsters.com Web Site, at any time, without ascribing any 
reasons whatsoever. 
 
4. These Terms of Use shall be governed and construed in accordance with laws 
of the Republic of Singapore. 
 
For full details, please view the Terms of Use document at :  
 
http://www.FridgeMonsters.com/administration/terms.asp 
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Introduction 
In this tutorial you will create and rig a simple leg with custom Attributes to allow 
more efficient animating. You will then create a copy of the leg, and rig it and 
create another set of custom Attributes. 
 
Learning Outcome 
The objective of this tutorial is to introduce you to the following :  
 

1. Create a Joint Chain to Rig a leg. 
2. Create IK handles for the Joint Chain. 
3. Create a Control Object. 
4. Organise the IK handles into Groups. 
5. Parent the IK handles Groups to the Control Object. 
6. Adjust the IK handles Group local axis. 
7. Create custom Attributes for the Control Object. 
8. Connect the custom Attributes to the IK handle Groups. 
9. Mirror the Joint Chain to create a second leg. 
10. Rigging the second leg. 
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Setting the Project 
 
The Project folder contains all the sub-folders for your project. It allows your 
scene to source for all the appropriate files and references in an organised 
manner. 
 
New Project 
File > Project > New 

1. Name the Project 
2. Location to Save the Project 
3. Set Folder Names 

 
Name the Project : lower case character, obvious names with no spaces 
Location of Project : The default location is set to Documents Folder, but if you 
are not working on your own computer it’s better to save it to the Desktop. Copy 
this Project folder to your portable device when you have finished this tutorial. 
 
Do not save your project to a portable drive (thumb drive) or the performance 
will lag. 
 
 

 
 
Name your project : toetap. Click the Use Defaults button to set the Project 
Data Locations. Then click Accept. 
 
 
 

 
 
 
 

www.FridgeMonsters.com Page 4 Chris Shaw 



 
 

www.FridgeMonsters.com Page 5 Chris Shaw 



Open the Joint Tool options. 
 
 Animation > Skeleton > Joint Tool > Options 

 
 

 
 

 
Reset the settings by clicking the Reset Tool button. 
 
 

 
 
 
Close the Joint Tool settings by clicking Ctrl + A. 
 
Maximise the Front viewport (SPACE BAR in Front viewport). Click and create 
Joints for the Hip, Knee, Ankle, Foot and Toes (see diagram below). 
 
Note : Remember to create the foot joint half along the foot (depending on your 
model). Holding the SHIFT key down will lock the position of the Joint horizontally 
or vertically as you click. This is useful for creating the last Joint for the Toes. 
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Press Enter to finish drawing the Joint Chain. 
 
Open the Outliner and name the Joints as listed below. Follow this naming 
convention : joint_side_character (eg. knee_l_robot01) 
 
Note : Do not use any spaces or capital letters in the names. 
 

 
 

 
Adjust the Joints positions using the local axis (Mac=Home : PC=Insert). When 
create a Joints Chain for your character, you should use your Model as a template 
(Put the Model on separate Layer and Template it). Check the position of the 
Joints in the Perspective viewport.  
 
After you have adjusted the Joints the local axis are no longer aligned to the Joint 
Chain. When you are confident the Joints are in position, select the Hip Joint 
(hip_l_robot01) and re-align the axis to the Joints.  
 
 Animation > Skeleton > Orient Joint > Options 
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Reset the Orient Joint Options. 
 
 Edit > Reset 
 
In this tutorial, the Joint Chain is created facing along the negative X axis. 
Therefore, the local X axis should be aligned along the Joints Chain. The local Y 
axis should define the “up” direction and the local Z axis should be the major axis 
for rotating the Joints. 
 
Under the Orientation setting, the order of axis defines alignment, up, rotation. In 
this tutorial you should select XYZ. 

 

 
 

Note : If you forget to Orient the Joints, they will rotate around arbitrary axis 
and make posing your character during animation a nightmare. 
 
Click Orient. 
 
The next task is to create the IK Handles for the Rig.  

 
Open the IK Handle Tool options. 
 
 Animation > Skeleton > IK Handle Tool > Options 
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Reset the settings by clicking the Reset Tool button. 
From IK Handle Settings, select ikRPsolver as the Current Solver. 
 

 
 
Close the Joint Tool settings by clicking Ctrl + A. 
 
Note : Remember to select ikRPsolver..!! 
 
Create 3 IK chains (see diagram below). The first starts at hip_l_robot01 and 
ends at ankle_l_robot01. 
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The second starts at ankle_l_robot01 and ends at foot_l_robot01. 
 

 
 

The third starts at foot_l_robot01 and ends at toe_l_robot01. 
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Open the Outliner and name the IK Handles as listed below. Follow this naming 
convention : name_side_ik_character 
 
Note : Do not use any spaces or capital letters in the names. 
 

 
 
 

The pivot point of an IK Handle is always located at the end of the IK chain. By 
Grouping each IK Handle you can then adjust the local axis (pivot point) of the 
Group and therefore create an IK Chain with pivot points where we need them.  
 
Select each of the IK Handles separately and Group them (Ctrl +G). 
Open the Outliner and name the Groups as listed below. Follow this naming 
convention : name_side_group 
 
Note : Do not use any spaces or capital letters in the names. 
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Adjust the Joints positions using the local axis (Mac=Home : PC=Insert). You 
can save a lot of time by pressing the V key to snap the local axis to the Joints. 
 
 W key (translate) > Mac=Home : PC=Insert > V key 
 
ankle_l_group 
 

 
 

toetap_l_group 
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toe_l_group 
 
 

 
 
Note : Remember to toggle the local axis mode off by pressing Mac=Home : 
PC=Insert again. 
 
Create Control Object using a NURBS Circle.  
 
 Create > Primitives > NURBS > Circle 
 
Then modify the Control Vertices to create a simple foot shape. Move it into 
place over the Joints Chain.  
 
Name the NURBS Circle controller_l_foot_robot01. 
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Delete the History and Freeze the Transformation. This is very important as in the 
future you’ll be able to reset your Characters Rig by setting all the Control 
Objects values to 0 (zero).  
 

 
 
 
 
 

 
 
 
 
Note : Don’t forget to do this..!! 
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Follow the steps below to create a Hierarchy with the Control Object and 3 
Groups.  
 

1. Select toe_l_group and SHIFT + select controller_l_group. Press P. 
2. Select ankle_l_group and SHIFT + select controller_l_group. Press P. 
3. Select toetap_l_group and SHIFT + select controller_l_group. Press P. 
4. Open the Outliner. Make ankle_l_group a Child object of toe_l_group by 

MMB on ankle_l_group and drag it on top of toe_l_group. 
 
 

Check the Outliner against the diagram below. 
 

 
 
Summary : You created a Joint Chain, adjusted it and re-oriented the local axis. 
You then added 3 IK Handles to the Joints Chain. The local axis of the IK Handles 
were in the wrong position. To solve this problem, you Grouped each IK Handle 
and then adjusted the local axis. You then created a Control Object using a 
NURBS Circle. You then Parented the 3 Groups to the Control Object. You finally 
adjusted the Hierarchy as shown in the diagram above.  
 
The Control Object(controller_l_foot_robot01) is therefore the Root of the 
hierarchy and the 3 Groups. Translating, Rotating and Scaling the Control Object 
now effects the 3 Groups. The 3 Groups contain the IK Handles and the these 
effect the Joints Chain.  
 
Note : Read the summary above again and make sure you understand what you 
have done so far and why. When you are ready, proceed with the tutorial.  

 
The objective now is to create a set of custom Attributes (sliders) for the Control 
Object to control the 3 Groups.  
 
Note : See the Appendix at the end of this document to see how each custom 
Attribute will effect the 3 Groups.  
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Select the Control Object(controller_l_foot_robot01). Open the Channel 
Window (right of the screen) and display the Attribute list.  
 

 
 

RMB on the list of Attributes and select Add Attribute. Follow the steps below to 
add a custom Attribute to the Control Object.  
 

1. Enter the Attribute Name : Toe_Tap 
2. Set the Data Type to Float 
3. Enter a Minimum value of -10 
4. Enter a Maximum value of 30 
5. Enter a Default value of 0 
6. Click Add. 
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Following the table below, add a total of 6 new Attributes to Control 
Object(controller_l_foot_robot01). 

 
 

Attribute 
Name 

Min 
Value 

Max 
Value 

Default 
Value 

Toe_Tap -10 30 0 

Tip_Toe 0 45 0 

Foot_Bend 0 45 0 

Heal_Roll -45 45 0 

Heal_Twist -30 30 0 

Heal_Tap -45 45 0 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

When you have finished, check the Attribute list against the diagram below (the 
order of the list may differ).  

 
 

 
 
 

 
You have now created 6 custom Attributes. They are in effect 6 empty sliders. 
The objective now is to connect each of the sliders to the Hierarchy created 
earlier.  
 
Each Attribute will have a 3 values Set on it. A Minimum, Maximum and Default 
value as defined in the table above.  
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OK, let’s start by setting the first 3 values for the Toe_Tap Attribute. Open the 
Set Driven Key options. 
 
 Animation > Animate > Set Driven Key > Set 
 

 
 
Create a Driven Key by following the steps below… 
 

1. Select the Driver object from the Outliner (controller_l_foot_robot01). 
2. Click Load Driver 
3. Select the Attribute (Toe_Tap) from the list. 
4. Set the value in the Attribute list (0). 
5. Select the Driven object from the Outliner (toe_l_group). 
6. Click Load Driven 
7. Select the Attribute (rotateZ) from the list. 
8. Set the value in the Attribute list (0). 
9. Click Key. 
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This will have Keyed a value of 0 on the Toe_Tap Attribute to 0 for the Z rotation 
of toe_l_group. 
 
Now repeat the steps to create the Minimum value.  
 

1. The Driver is already loaded (controller_l_foot_robot01). 
2. Attribute (Toe_Tap) is already selected. 
3. Set the value in the Attribute list (-10). 
4. The Driven object is already loaded (toe_l_group). 
5. The Driven Attribute (rotateZ) is already selected. 
6. Set the value in the Attribute list (-10). 
7. Click Key. 

 
 
Now repeat the steps again to create the Maximum value.  
 

8. The Driver is already loaded (controller_l_foot_robot01). 
9. Attribute (Toe_Tap) is already selected. 
10. Set the value in the Attribute list (30). 
11. The Driven object is already loaded (toe_l_group). 
12. The Driven Attribute (rotateZ) is already selected. 
13. Set the value in the Attribute list (-30). 
14. Click Key. 

 
 

Done..!! You’ve now created a Set of 3 Driven Keys. To see the result select the 
Control Object(controller_l_foot_robot01). Reset the Toe_Tap value back to 0 
and the toe_l_group return to the default rotation.  
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Now select the Attribute label (not the value) in the Attribute window. MMB 
button in the viewport and drag the mouse left and right to  
 
 
Follow the table below and create a Set of 3 (Default, Min and Max)Driven keys 
for each of the 6 Attributes.  
 
Note : Remember you need to Load a different Driven for each Set of 3 Keys.  

 
 

 

Attribute 
Name 

Driver Driven 
Min 

Value 
Max 

Value 
Default 
Value 

Toe_Tap controller_l_foot_robot01 
toetap_l_group 

rotation Z 
-10 30 0 

Tip_Toe controller_l_foot_robot01 
toe_l_group 

rotation Z 
0 45 0 

Foot_Bend controller_l_foot_robot01 
ankle_l_group 

rotation Z 
0 45 0 

Heal_Roll controller_l_foot_robot01 
controller_l_foot_robot01 

rotation X 
-45 45 0 

Heal_Twist controller_l_foot_robot01 
controller_l_foot_robot01 

rotation Y 
-30 30 0 

Heal_Tap controller_l_foot_robot01 
controller_l_foot_robot01 

rotation Z 
-45 45 0 
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Appendix : Yellow Dot indicates pivot point (axis) 
 

Attribute 
Name 

Image Driven 
Min 

Value 
Max 

Value 
Default 
Value 

Toe_Tap 

 

toetap_l_group 

rotation Z 
-10 30 0 

Tip_Toe 

 

toe_l_group 

rotation Z 
0 45 0 

Foot_Bend 

 

ankle_l_group 

rotation Z 
0 45 0 

Heal_Roll 

 

controller_l_foot_robot01 

rotation X 
-45 45 0 

Heal_Twist 

 

controller_l_foot_robot01 

rotation Y 
-30 30 0 
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Heal_Tap 

 

controller_l_foot_robot01 

rotation Z 
-45 45 0 
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